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Abstract —This research is focused in the study of local climate effects due to urbanization in tropical coastal cities.
With the use of remote sensing technology, climate changes due to urban growth can be detected. The clearest local
indicator of climate changes due to urban growth is a urban/rural convective circulation known as Urban Heat
Islands (UHI). The main scientific objective of this research is to investigate the impact of the fast urbanization in
the local climate of tropical coastal cities that is related to UHI. The Airborne Thermal and Land Applications
Sensor (ATLAS) from NASA/Stennis that operates in the visual and IR bands was used as the main sensor for this
study with the objective of investigating the Urban Heat Island (UHI) in San Juan, Puerto Rico. Temperatures as
high as 60°C over the developed areas differ from temperatures over vegetated areas of more than 30°C during
daytime. The UHI curve over the San Juan area is a clear evidence of the characteristic high temperature domes over
urbanized areas. Correlations between temperature and albedo provide additional information of the different
surface energy budget components. The Normalized Difference Vegetation Index (NDVI) was also estimated to
separate the land use and land cover components over the San Juan area. Results from this research have shown
outstanding evidence of elevated surface temperatures over the urban landscape and clearly validate the
development of UHI in San Juan, Puerto Rico.
Keywords —surface, temperature, albedo, energy, urbanization, NDVI, land use.
I. INTRODUCTION
It is difficult to imagine that cities in small tropical
islands show local climate change effects similar to
those in great continental cities. It was recently
discovered in (González et al., 2006) that this might
be the case for the city of San Juan, Puerto Rico, a
relatively affluent coastal tropical city of nearly 2
million inhabitants. The main scientific objective of
this research is to investigate the relationship between
urban growth, land cover change, and the
development of the urban heat island phenomenon
over a tropical coastal city; San Juan, Puerto Rico.
Also study the overall effects of urban development
on surface energy budget characteristics across the
urban landscape through time at nested spatial scales
from local to regional. A field campaign was
designed and executed in February 2004 to validate
this phenomenon. The field campaign included onboard high resolution infrared sensors, ground
stations, and upper air balloons. The Airborne
Thermal and Land Applications Sensor (ATLAS)
from NASA/Stennis that operates in the visual and IR
bands was used as the main sensor for this field
campaign with the objective of investigating the
Urban Heat Island (UHI) in San Juan, Puerto Rico.
Infrared sensor measurements can provide land

surface parameters such as temperature and albedo.
These two parameters are the key elements in the
study of urban heat island. A brief review of relevant
works is provided in this section.
Landsat 7 has been used in urban heat island
studies in the city of Atlanta (Poreh, 1996). This
sensor has a spatial resolution of 60 m in the spectral
range of 10.40 to 12.5 µm. One constraint of the
instrument is the temporal variation due to overpasses
through Puerto Rico which is every 16 days. To
retrieve surface temperature, band 6 is adjusted with
an atmospheric model or profile. (Fukui et al., 2002)
presented a study based on the surface temperature
distribution and the urban structure in Tokyo using
the Advanced Spaceborne Thermal Emission and
Reflection Radiometer (ASTER) and LIDAR data.
ASTER has a spatial resolution of 90m in the spectral
range of 8.125 to 8.825µm, 8.925 to 9.275µm and
10.25 to 11.65µm. In this study, two different scenes
from ASTER were used to calculate the surface
temperature via the temperature/emissivity separation
(TES) algorithm. The correlation of the surface
temperature and the urban structure shows the impact
of green areas on the urban heat environment and the
falling of surface temperature in tall buildings during
daytime and increasing of surface temperature during
nighttime. Furthermore, NOAA Advanced Very High

Resolution Radiometer (AVHRR) thermal IR images
have been studied to understand the urban
microclimates of cities such as Paris and Los Angeles
(Dousset and Gourmelon, 2001). This radiometer has
a spatial resolution of 1km and two thermal bands in
the spectral range of 10.3 to 11.3µm and 11.5 to
12.5µm. To retrieve surface temperature, it uses a
split window equation. MODIS has the same
resolution as NOAA AVHRR but has the capability
of acquiring data over 36 spectral bands. (McCabe et
al., 2001) compared MODIS and NOAA AVHRR
land surface temperatures with ground based infrared
thermometry measurements made in Tomago,
Sandbeds,
north
of
Newcastle,
Australia.
Comparisons show good agreement between
MODIS, NOAA AVHRR and the infrared
thermometer. (Quattrochi and Luvall) explain in
detail the surface temperature retrieval from these
instruments. No major research has been reported
where remote sensing images are used to investigate
the urban climate in tropical and subtropical regions.
The remaining parts of the paper are organized as
follow: Section II presents the theoretical aspects and
the post-processing of the ATLAS data, Section III
presents results obtained from the San Juan area,
Section IV includes the conclusions and the future
work,and finally, Section V includes the references.
II. ENERGY SURFACE BUDGET DEFINITIONS
AND ATLAS DATA POST-PROCESSING
The Airborne Thermal and Land Applications Sensor
(ATLAS) of NASA/Stennis operates in the visual and
infrared bands. The ATLAS can detect 15
multispectral channels of the radiation through the
visible, near infrared, and thermal spectrums (see
Figure 1 and 2). The sensor also incorporates the
active sources of calibration needed for all bands.
The data is corrected for the atmospheric radiation,
and georectified before the analysis of the data is
performed. The ATLAS sensor has been used in
other field campaigns to investigate the UHI in
Atlanta, Salt Lake City, Baton Rouge, and
Sacramento, all in the continental mass of the United
States of North America described in (Luvall et al.,
2005).

Figure 1. Spectral resolution of the airborne thermal and
land applications sensor(ATLAS). Bands 1-8.

Figure 2. Spectral resolution of the airborne thermal and
land applications sensor(ATLAS). Bands 10-15.

The ATLAS Mission of San Juan, Puerto Rico was
conducted during February of 2004 to investigate the
impact of the urban growth and landscape in the
climate of this tropical city. The flight plan of the
mission covered the metropolitan area within San
Juan, the national forest of El Yunque to the east of
San Juan, the city of Mayagüez in the west coats of
Puerto Rico, and the Arecibo Observatory located in
the north-central coast, for a total of 25 flight lines.
The downtown area of San Juan, Hato Rey, was
covered in a horizontal resolution of 5 meters in
flights during the day and during the night. The
remaining areas of the city were covered in 10 meters
of resolution. The flights were executed between the
11 and the 16 of February of 2004. In order to
analyze the existence of an urban heat island in San
Juan, and to support the data of the ATLAS sensor,
several experimental campaigns for data collection
were designed and conducted by different teams, in
addition diverse numerical experiments were
performed that helped to understand the phenomenon
and its characteristics.
The atmospheric corrections needed to produce
calibrated data sets from ATLAS involve a complex
procedure. They require direct measurements of the
atmosphere extinction coefficients by wavelength and
profiles of atmospheric temperatures and water
vapor. ATLAS instrument characteristics and
calibration are also required. Figure 3 details the
process flow followed for this project including
resulted images from every relevant routine. A
combination of software was used for the processing,
including the public domain image processing/remote
sensing package ELAS (Beverley and Penton, 1989)
and a series of custom programs, Watts and Energy
from ELASII (Rickman et al., 2000).
MODTRAN4 (Berk et al., 1999) was used to
model the atmospheric radiance and transmittance
using input from radiosonde data and shadow band
radiometers. (Rickman et al., 2000) details the
procedure for calibrating the ATLAS sensor to
produce the system transfer function to convert
digital values (DV) into radiance measurements.
These procedures produce ATLAS data files that are
in physical units of energy. These files are used for

the generation of files which derive albedo and
surface temperature.

Figure 3.ATLAS overall data-processing flowchart.

Surface temperature is a major component of the
surface energy budget. In (Oke, 1987) the use of
energy terms in modeling surface energy budgets
allows the direct comparison of various land surfaces
encountered in a landscape, from vegetated (forest
and herbaceous) to non-vegetated (bare soil, roads,
and buildings). The partitioning of energy budget
terms depends on the surface type. In natural
landscapes, the partitioning is dependent on canopy
biomass, leaf area index, aerodynamic roughness, and
moisture status, all of which are influenced by the
development stage of the ecosystem. In urban
landscapes, coverage by man-made materials
substantially alters the surface energy budget. The net
all-wave radiation balance (W/m2) of landscape
canopies can be determined as follows (Oke, 1987).
The net solar radiation, K *, is given by
K*= (1-a)(K↓)
(1)
where a is the site albedo and K↓ is the incoming
solar radiation. The albedo is defined as
a=((K↑)/(K↓))
(2)
where K↑ is the reflected solar radiation. The long
wave energy emitted from a surface (L↑) is
dependent on surface temperature:
(3)
L↑=ε[σT4]
where ε is the emissivity and σ is the StefanBoltzman constant (5.7x10-8W/m²-K4) and T is the
land surface temperature (Kelvin). The net long wave
radiation at the surface, L*, is given by
L*=L↓-L↑
(4)

where L↓ is the long wave radiation from the
atmosphere. The net all-wave radiation, Q *, can be
given as:
Q*=K*+L*
(5)
Net radiation, under most conditions, represents the
total amount of energy available to the land surface
for partitioning into non-radiative processes (mass
heating, biological synthesis, etc.) at the surface. It is
the amount of energy the system holds on to and
degrades. In vegetated areas the amount of net
radiation is dependent upon vegetation type and
varies with canopy leaf area and structure. The net
radiation may be expressed as the sum of these nonradiative fluxes:
Q*=λE+H+G
(6)
where H is the sensible heat flux, λ is the latent heat
of vaporization of water, E is the transpiration flux
and G is the energy flux into or out of storage (both
canopy and soil). The partitioning λE, H and G are
also dependent on the makeup of the surface. Both
the physiological control of moisture loss (stomatal
resistance) and leaf/canopy morphology for
vegetation determines how Q* is partitioned among
λE, H, and G. For urban surfaces the coverage of
both man-made materials and vegetation results in a
heterogeneous mixture of surfaces which determine
the partitioning of energy. The ATLAS remotely
sensed data allows the measurement of important
terms in the radiative surface energy budget: K↑ and
L ↑ on a urban landscape scale. When combined with
output from MODTRAN4 (Berk et al., 1999)
atmospheric radiance models the remaining terms
and Q* can be determined.
III. MATERIALS AND METHODS
The image processing software that was used in this
laboratory was ENVITM. Images from San Juan,
Puerto Rico at a spatial resolution of 10 meters, Hato
Rey at a spatial resolution of 5 meters and El Yunque
at a spatial resolution of 10 meters were acquired by
ATLAS. The dataset products were WATTS
MOSAIC and ENERGY MOSAIC. Since the
ATLAS datasets are not compatible with the ENVITM
software, new ENVI formatted headers were created
(see Appendix 1 for more information).
Different tasks were performed to obtain information
about the urban climate phenomena studied.
1) Normalized Difference Vegetation Index
The first step was to open and interpret the WATTS
MOSAIC image to examine the Red and Infrared
bands. The second step was to select the Red channel
that absorbs more and the Infrared channel that
reflects more. The third step was to calculate the

NDVI for the image using by entering the equation
(7) in the Band Math basic tool of ENVITM.
NDVI= ((float(b6))-(float(b4)))/((float(b6))+(float(b4))) (7)

where b4 is the spectral reflectance in the Red Visible
Band and b6 is the spectral reflectance in the NearInfrared Band from the WATTS MOSAIC datasets.A
mask was prepared to filter values out of the range
between 0 and 1 by using the Build Mask basic tool.
A scale bar was added to the image by using the
ENVITM Color Tables under the Color Mapping tool
and then a Color Ramp Object under the Annotation
tool from the Overlay menu.

uses the mean vectors of each endmember and
calculates the Euclidean distance from each unknown
pixel to the mean vector for each class. All pixels are
classified to the nearest class unless a standard
deviation or distance threshold is specified, in which
case some pixels may be unclassified if they do not
meet the selected criteria. The Euclidean distance or
Euclidean metric (defined in Fukunaga, 1990) is the
distance between two points P = ( p1 , p 2 , p3,..., p n )
and Q = (q1 , q 2 , q3,..., q n ) , in Euclidean n-space, is

defined as:
n

D E ( p, q ) =

∑( p

i

− qi ) 2

(9)

i =1

2) Multispectral Classification
The first task was to perform unsupervised
classification of the WATTS MOSAIC datasets.
ENVITM provides two different unsupervised
classifiers: isodata and k-means.
As explained by the ENVITM helper, isodata
calculates class means evenly distributed in the data
space and then iteratively clusters the remaining
pixels using minimum distance methods. Each
iteration recalculates means and reclassifies pixels
with respect to the new means. Iterative class
splitting, merging, and deleting are done based on the
input threshold parameters. All pixels are classified
to the nearest class unless a standard deviation or
distance threshold is specified, in which case some
pixels may be unclassified if they do not meet the
selected criteria. This process continues until the
number of pixels in each class changes by less than
the selected pixel change threshold or the maximum
number of iterations is reached. The isodata
classification of the images was realized with the
default parameters.
In theory, k-means is an algorithm to cluster
objects based on attributes into k partitions. The idea
of the algorithm is to find the centers of natural
clusters in the data. The objective is to minimize total
intra-cluster variance, or, the squared error function.
2

k
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(8)

i =1 x j ∈Si

where there are k cluster Si, i=1,2,…,k and μi is the
centroid or mean point of all the points xj∈Si. The
procedure is similar to isodata. In the case of kmeans, the images were classified for 10 classes and
2 iterations were done.
The second task was to perform supervised
classification of the subset image by using the
minimum distance, Mahalanobis distance and
maximum likelihood classifiers. As explained by the
ENVITM helper, the minimum distance technique

Maximum Likelihood (ML) is a parametric classifier
that uses the training samples to estimate some
parameters such as mean vector and covariance
matrix. This is the most common supervised method
used with remote sensing image data (Richards,
1993). This method involves specifying the joint
probability distribution function for the sample data.
Under relatively weak assumptions, usually called
regularity conditions, maximum likelihood estimates
are consistent, asymptotically normal, and efficient.
Consistency means that as the sample size increases,
the ML estimate tends in probability to the true
parameter value. Moreover, for large sample size,
the ML estimate will have an approximate normal
distribution centered on the true parameter value.
The spectral classes for an image be represented by
ω i = 1,....M where M is the total number of
classes. The probability p(ωi\x) gives the likelihood
that the correct class is ωi for a pixel at position X.
Then, the classification is performed according to X
⎛ ω j ⎞ for all j≠i.
ε ωi if
The
⎛ω i ⎞
⎜
⎟
p⎜
⎟ > p⎜
⎟
⎝ x ⎠
⎝ x ⎠

Multivariate Normal Class Model, if we assumed N
bands is:
⎛ x
p ⎜⎜
⎝ωi

⎞
⎟⎟ = (2π
⎠

−N

)2

∑i

−1
2

⎧−1
(x − m i )t ∑ i −1 (x − m i )⎫⎬
exp ⎨
⎩ 2
⎭

(10)
where mi and ∑i are the mean vector and covariance
matrix of the data in class ωi .
Mahalanobis distance is a parametric classifier that
uses the training samples to estimate some
parameters such as mean vector and covariance
matrix. It is a distance measure introduced by P. C.
Mahalanobis in 1936. It is based on correlations
between variables by which different patterns can be
identified and analyzed. It differs from the Euclidean
distance in that it takes into account the correlations
of the data set and is scale-invariant, that means that
it’s not dependent on the scale of measurements. The

Mahalanobis distance from a group of values with

mean μ = (μ1 , μ 2 , μ 3,..., μ n ) and covariance matrix Σ
T

for a multivariate vector x = (x1 , x 2 , x3,..., x n )T is
defined as:
DM ( x) = ( x − μ ) T Σ _ 1 ( x − μ )

(11)

A ROI (region of interest) file was prepared with 5
classes: ocean, lakes, forest, agriculture and cities.
This ROI file will be used as training samples for the
supervised classifiers. By result, three different
images were produced. Every image created was
saved in ENVITM and jpeg format. The final task is to
compare the images and discuss about the similarities
and differences between the results.
3) Correlations between surface parameters

Albedo alone does not truly reflect how the lands'
surface partitions energy. A good example is the
comparison between vegetated and asphalt surfaces (
see Table 1). Both surfaces have a low albedo, but
the asphalt surface temperature can be over 34ºC
greater than the vegetated surface. If the surface
temperature is included the needed additional
information to asses the "urban fabric" of the city is
provided. The surface temperature and albedo
classifications represent a functional classification of
that surface, that can readily be incorporated into the
surface parameterization of meteorological and air
quality models. Within each city, each land use has a
unique "energy print" that is directly physically
related to how that surface is processing energy.
These "energy prints" of the land use are unique for
each city.
Surface
Water
Desert
Fresh snow
Old snow
Green forest

Albedo %
5-10
25-30
80-90
45-70
5-10

Green leaves

5-25

Clouds (average)

50-55

Clouds < 150 m thick

25-63

Clouds 150-300 m thick

45-75

Clouds 300-600 m thick

59-84

Sea ice
Bitumen road

30-40
5-10

Table 1. Albedo values for different surfaces.

Surface parameters such as the temperature and
albedo were obtained from the ENERGY MOSAIC
datasets. The first steps to visualize this correlation is
by selecting the two surface parameters and
displaying them in ENVITM, then go to Image
Menu/Tools/2-D Scatter plots and select the X-band
and the Y-band to be displayed. A window with a
scatter plot will appear. By moving the window box
through the image, one can select the area to be
observed.
4) Urban Heat Island Curve

To show evidence of the elevated temperature domes
that are characteristic of urban areas with surrounding
rural areas that present low temperature patterns, a
UHI curve must be plotted. First, the surface
temperature must be selected from the ENERGY
MOSAIC datasets and displayed in ENVITM. Then go
the Image Menu/Tools/Profile/Arbitrary Profile
(Transect) and select the path over the image to be
observed.
IV.RESULTS and DISCUSSION
NDVI results from San Juan, Puerto Rico show the
dominant city (white pixels) surrounded by rural
areas (mostly green pixels). Oceans, lakes and rivers
can be well distinguished with black pixels. Figure 4
show the NDVI generated image by ENVITM for the
San Juan Metropolitan area. In Figure 5, a different
contrast between forest and coastal cities is observed.
El Yunque, at the East of Puerto Rico, predominates
with green pixels surrounded by coastal cities in
white pixels. Results from Hato Rey also show
similar relation between pixels(see Appendix 2).

Figure 4 NDVI values for the San Juan Metropolitan
area and its surroundings.
Two different tasks were performed: one for
unsupervised classification and the second for
supervised classification. Figure 6 shows the

classified image using the isodata classifier and
figure 7 shows the classified image using the kmeans classifier. What is more obvious is that ocean
is very well classified in the three images. The
isodata classifier detects better the vegetation and the
cities pixels.

The supervised classification of the images shows a
different scenario in which 5 classes are selected:
ocean, lakes, forest, agriculture and cities. Based on
these samples, the supervised algorithm is executed.
Figure 8-10 shows the classified image based on
minimum distance, Mahalanobis distance and
maximum likelihood, respectively. Minimum
distance didn’t make distinction between ocean and
lakes pixels. On the other part, maximum likelihood
shows a better overall performance. Also agriculture
and forest pixels are discriminated better in the
maximum likelihood classified image.

Figure 5 NDVI values for the East of Puerto Rico.

Figure 8 Supervised classification using the Minimum
distance classifier.

Figure 6 Unsupervised classification using the Isodata
classifier.

Figure 9 Supervised classification using the Mahalanobis
distance classifier.

Figure 7 Unsupervised classification using the K-means
classifier.

Compared to the unsupervised classifiers, this one
works better for the distinction of cities and
vegetation. By just looking at the classified images,
it seems that the supervised minimum distance
classify better. In this type of exercise, the
unsupervised classifiers were not effective. Another
important observation is the selection of samples to
be trained by the classifier, they make a big
difference. One important observation about the

images is that river pixels did not vary from highway
pixels which seem to be a problem to discriminate
one class from the other. One good recommendation
is to use surface temperature ranges for rivers and
roads when selecting the ROIs. (Fukunaga, 1990)
proves that second-order classifiers (such as
minimum distance and maximum likelihood) can
discriminate very well by using a quadratic relation
between training samples and dimensionality. On the
other side, unsupervised classifiers like isodata and kmeans do not depend on the samples and it may
result in a disadvantage. In this case, dimensionality
is not tested but it seems that a combination of
dimensionality and training samples can lead to a
better classification. This might be a good future
exercise.

most vegetated areas in the city shows a very low
contribution of surface temperature vs albedo.
Generally the industrial areas had the highest albedo,
and the hottest temperatures. The park areas show the
lower albedo (not always the lowest) and lowest
temperatures. Residential areas reflect low albedo
values in a range from low to high surface
temperatures. The airport area is mostly an asphalt
surface that can be very hot in terms of temperature.
The hottest surfaces correlate with roofs and asphalt
pavements. See Appendix 2 for more results.

Figure 11 San Juan scatter plots that identifies the energy
portions from urbanized and vegetated areas at differents
spots.

Figure 10 Supervised classification using the Maximum
Likelihood classifier.

The San Juan Metropolitan zone includes vegetated
areas such as the Experimental Station, lake, airport,
coastal industrial areas such as Cataño and central
building areas. Differences in temperatures indicate a
heat pattern dominating urban and coastal areas.
Vegetated areas reflect albedo values around 0.07
and 0.15. Water bodies reflect albedo values around
0.06 and 0.3. Albedo values higher than 0.78
correspond to cloud bodies. Since the San Juan
Metropolitan zone includes vegetation, water bodies,
residential, industrial and central building
components, the surface energy budget can be
evaluated by observing the energy contribution of
each component to the whole UHI energy print. The
way each surface partitions energy is unique
depending on material type, vegetated or nonvegetated, water status, atmospheric vapor deficits,
and the relative mixtures and arrangements of the
various components of that surface. Figure 11 shows
an image of San Juan with its relative surface energy
components. Individual vegetated components such
as the Experimental Station Area which is one of the

Finally, the evidence of UHI over the San Juan area
can be represented by the temperature curve(see
Figure 12). The concept of UHI domes over the city
can be represented by using the Transect tool of
ENVITM. Using this method with remote sensing data
can be more convenient than selecting points and
creating an Excel graph.

Figure 12 Temperature curve for the San Juan Metropolitan
area showing domes of elevated temperatures over the
downtown area.

V. CONCLUSIONS
The work presented is part of a comprehensive
investigation of the impact of land use for
urbanization on the environment of a city located on
a small tropical island, in this case, San Juan, Puerto

Rico. The ATLAS field campaign conducted in
February 2004 validates the development of UHI
showing temperatures as high as 60°C with
temperature differences between the developed and
vegetated areas of more than 30°C during daytime.
Classification methods are very important in the
analysis of UHI data. Supervised classifiers show a
higher level of performance when detecting surface
components from a city. Correlation between surface
temperature and albedo show the thermal
characteristic of energy prints. These prints represent
the surface energy portion from the urban city
component that contributes to the total surface energy
budget. Surface temperature, albedo and NDVI
results from San Juan show evidence of the urban
growth impact in a tropical coastal city. Because
ATLAS also has superior spectral resolution within
the thermal IR channels, it offers the potential to
make accurate measurements of thermal responses
for different landscape characteristics and their
corresponding land-atmosphere interactions over
small wavelength regions. Energy prints from the
different components in a urban city represent the
surface energy portion that contributes to the total
surface energy budget. Future work will include the
validation of the supervised classifiers to create a
table with the characteristic surface temperature and
albedo for every surface.
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APPENDIX 1
How to read ATLAS data in ENVITM

Because ATLAS data is written in formats not recognized by ENVI, several steps must be done to read
ATLAS data. Raw data is written in .flat and .img formats. Atmospherically corrected data product is a .wats
output from the ELAS software. Geometrically corrected data product is a .geo output from the ELAS software.
Surface data product is an .energy output from the ELAS software.
In the File Menu, select Open Image File to open ENVI image files (flat binary files) or other binary image
files of known format.
1.

Select File → Open Image File.

2.

When the Enter Data Filenames dialog appears, select the file to open by clicking on its name and clicking
OK or Open.

3.

When ENVI first opens a file, it requires specific information regarding the file characteristics. If the file
is an ENVI format file, the necessary information is contained in a separate text header file. The text
header file has the same name as the image file, but the file extension is .hdr.
If ENVI cannot find the header file (.hdr file) or other valid header information upon opening a file, the
Header Info dialog box appears (see Figure 13). You must enter the required information into the dialog
before an imported image can be displayed in ENVI. The information needs to be entered only once and is
automatically stored into an ENVI header file in the input directory when the OK button at the bottom of
the Header Info window is selected.

Figure 13 Header Info dialog box.

Use the Header Info dialog to enter this information:
•

The Samples field displays the number of samples in the file.

•
•
•
•
•
•
•

The Lines field displays the number of lines in the file.
The Bands field displays the number of bands stored in the file.
The Offset field displays the offset in bytes from the start of the file to where the actual data begins. (The
Offset is sometimes known as the embedded header.)
The xstart and ystart fields define the image coordinates for the upper left- hand pixel in the image. The
default values are (1,1) so that the upper left hand pixel has an image coordinate of (1,1).
Use the Data Type pull-down menu to select the appropriate data type (byte, integer, unsigned integer,
long integer, unsigned long integer, floating point, double precision, 64-bit integer and unsigned 64-bit
integer, complex, or double complex).
Use the Byte Order pull-down menu to select the byte order of the data. This parameter varies by platform:
o For DEC machines and PCs, select Host (Intel), for the host least significant first byte order.
o For all other platforms, select Network (IEEE), for the network most significant first byte order.
Use the Interleave menu to select the data storage order from these choices(see Table 2):
o BSQ — band sequential
o BIL — band interleaved by line
o BIP — band interleaved by pixel

Table 1 Band storage order description.

File Format
BSQ
BIL
BIP

Minor Frame
# of samples (line)
# of samples (line)
# of bands (spectrum)

Major Frame
# of samples by # of lines (band)
# of samples by # of bands
# of bands by # of samples

All additional information stored in the ENVI Header is optional. To access this optional information, click
the Edit Attributes button in the Header Info dialog. This optional information includes setting the default
Z-Plot range, default stretch for display, entering georeferencing information, associated wavelengths and
associated FWHM (full-width-half-maximum) values, sensor type, band names, and bad bands.
Map information is associated with georeferenced files. In ENVI, the term georeferenced refers to images
that have been geometrically corrected (i.e., rectified) such that they conform to a known projection. To
establish the georeferenced data coordinate system, you must know the sample and line coordinates of one
pixel (the reference pixel), the pixel size, the map projection, and map coordinates of this pixel.
4.
5.
6.
7.

After the file is opened, the bands are listed in the Available Bands List.
In the Available Bands List, click on the Display #X button menu (where X is the number corresponding to
the number in a display window's title bar) and select the display from the list.
To start a new display, select New Display from the button menu.
Click Load Band or Load RGB to load the selected bands into the active display (see Figure 14).

Figure 14 Display of the selected bands.

APPENDIX 2: Additional figures

Figure 15 NDVI values for the Hato Rey downtown area.

Figure 16 Additional scatter plots for residential and building areas.

Figure 17 Additional scatter plots for vegetated and industrial areas.

